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Logging in to TeamSite e
1. Open a Web browser window on “Jgﬂmﬂ “ PUMF?WFP@MW{P

your computer. We recommend
using Internet Explorer version

Username: |

6.0 Or higher. Password:
2. In the address bar, type ContentCenter: oo
https://teamsite.oregon.gov. Role: uthor v
3. In the Username field, type your

TeamSite username.

4. In the Password field, type your
TeamSite password.

5. In the Content Center drop down
box, select “Professional.”

Pawersd by Interwoven

6. In the Role drop down box, select
Author.

7. Click the Login button (Figure 1).

igure 1: The Login Window -

How to find your agency folder
Click on the Content Tab, and under Branches follow the steps below:

Expand (open) the ‘m1196uspin2.cust.aops-eds.com’ server icon
Expand the ‘default’ icon

Expand the ‘main’ icon

Expand the ‘State of Oregon’ icon

Expand your ‘agency’ icon

Expand the “Internet’ icon

Click the ‘Workareas’ icon

Click your ‘agency’ icon on the right side

© 0 N o Ok~ DR

Click your ‘agency’ on the left side
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Figure 2: Finding your directory

10.You should see the Jobs folder on both left and right side of the screen
(Figure 3).
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Figure 3: Jobs folder



Starting your Job Announcement template

There are two main areas of the Content Center Professional environment: the Content
tab and the Workflow tab. From the Content tab, you will manage and work on
individual files. From the Workflow tab, you will manage your file workflows and
associated jobs. You can toggle between these two work areas by clicking the Content
or Workflow tab on the top of your TeamSite screen.

1. To get started on your job announcement click on the Content tab, if you are not
already in the Content work area.

Oregon.govf’ﬂl‘ffFMUY‘!ﬁrlNTERWUVEN Logout | About | Help

File Edit Yiew Actions ':><pCompare 3 1mport | & Edit| 2 Preview | 7 Submit

Figure 4: Content and Workflow tabs

2. Ensure that you are in the jobs folder where you will be saving this new page.

3. Select New Form Entry from the File drop-down menu (Figure 5).

Oregon.goV rowered by R INTERWOVEN
Content | warlflow

File Edit ¥iew Actions

%ew Farrm EnfrD
£

{1 Mew Zubdirectories

Irmport
Mawve
Renarne

Tag
Wersions

Properties

Delete Content
Unpublish

H ) FAC

Figure 5: Selecting the New Form Entry option
4. Select the Job Announcement template under Agency Pages by clicking within
the circle before the template name.

5. Click the Next button. A blank Job Announcement template will appear on your
screen (Figure 5).



Edit job_announcement Help
1 untitled E] save | B] Save as | Q. Preview
Use this template to create / modify the Job Announcernents to be posted to the State of Oregon Jobs page. ~

-| Post_Code_S5ection

Announcement

>
Postcode 0 | ¢ e

Class_MNumber_Section

Classification * (2

Working Title (2
2

OpenfRevised - Revised
Date * (7 mm/ddyyyy View Calendar Description (2

2]

Close

Close Date * (2 |mnmn/dd/yvyyy View Calendar Description (?

Statewide

Ada .
Announcement
Location * (7 adams Branch * (7 EXB.CL.JUVB & Internal
Judicial Type © 12
Adel External

Adrian Legislative

<< Back Finish Cancel

Figure 6: Job Announcement Template

A few things to note with the job announcement template

e You can click on the picture of the ? mark and get a field description.
e There is a Back button feature.

e All of the sections have replicants + or -.

e Everything with an asterisk needs to be filled in.

e You will need to have the Visual Format Editor (VFE) installed on your
computer in order to put the body of your announcement in the template.

e If you have a pop-up blocker turned on you will need to turn it off. Several
of the features within TeamSite (calendar) are pop-ups and will not work.



The Post Code section

This is the job category where the announcement will appear on the jobs page. The
user must choose from the twenty-two selections in the drop-down box. * This is a
required field and cannot be left blank.

Edit job_announcement

7 Untitled

Use this ternplate to create / modify the Job Announcements to be posted to the State of Oregon Jobs page.

= Post_Code_Section

Post Code 2 D702 - MARNAGEMEMT, ADMINISTEATIVE, and SUPERVISORY

Figure 7: Post Code Section

Announcement Number
The first two digits identify the

Announcement
announcement type and must be OC, SW, ¥ Number *

AP, LE, JR, ES, OL, or NC. Enter your
agency’s code as the 3rd and 4th digits. This
identifies the announcement as being developed by your agency. You may develop
your own process for assigning the 5th, 6th, 7th, and 8th digits. The 9th digit will
only be used for an announcement being augmented. For a first augment use the
suffix code of A; second augment use the suffix code of B, etc. *This is a required
field.

Figure 8: Announcement Number

Classification Number

This is the classification of the position being || = class_Number_Section
filled. The user must select a classification
code from the drop-down selection box. The

Classification © (7

information is ordered by service type and Figure 9: Class Number

classification number. This information is downloaded from the PPDB system. The
classification title on the job announcement is based upon this entry and cannot be
edited by the user. *This is a required field.



Working Title

This is the working title for the position being filled. Do not include parenthesis. It
should not be the same as the classification title.

Working Title 2

Figure 10: Working Title

Open/Revised Date

User may type in a date or click on the view calendar button to enter the open date.
The date entered must be a valid six digit date formatted with slashes. * This is a
required field.

OpenfRevised

Date * (7 rnrn o d Sy View Calendar

Figure 11: Open/Revised Date

Revised Description

The maximum number of characters for the Revised Description is 50. If a revised
description is entered, the Open Date is changed to Revised Date in the output of
the job announcement.

Revised
Description 7

Figure 12: Revised Description

Close Date

User may type in a date or click on the view calendar button to enter the close date.
The date entered must be a valid six digit date formatted with slashes. * This is a
required field, unless a close description has been selected from the drop-down
selection box.

Close Date * (2) |\mm/dd/yyyy Wiew Calendar

Figure 13: Close Date



Close Description

Select a close description from the drop down selection box when there is no
established close date.

Close

Description ?

Figure 14: Close Description

Location

User selects location(s) from the drop-down selection box. Holding down the "Ctrl"
button allows multiple selections. * This is a required field; at least one location
must be selected.

Statewide
Ada
Location * Adams
Adel
Adrian

Figure 15: Location

Branch
User selects the branch of government. * This is a required field.

Branch Executive

Judicial
Legislative

Figure 16: Branch of Government

Announcement Type

Select Internal for announcements that are limited to existing agency staff such as
agency promotional or job rotation announcements, and for statewide promotions
that are limited to current state employees. Select External for announcements that
are open for anyone to apply for. * This is a required field.



Aannouncement
T 5 Internal
External

Figure 17: Announcement Type

Salary Range Minimum

Enter minimum salary. Must be numeric, do not enter a dollar sign or commas.
* This is a required field.

Salary Range
Minimun 2

Figure 18: Salary Range Minimum

Salary Range Maximum

Enter maximum salary. Must be numeric, do not enter a dollar sign or commas. If
the position you are posting does not have a salary range just type in a zero. *This
is a required field.

Salary Range
Maximum | #

Figure 19: Salary Range Maximum
Salary Range Type

User selects a descriptor for the salary range amounts entered.
*This is a required field.

Salary Range HOLRBLY

Type * 12 PO THLY
ARMUALLY

Figure 20: Salary Range Type



Announcement Text

This is the place to enter the actual text of the job announcement; such as, General
Information, To Qualify, Duties and Responsibilities, Working Conditions, This is the
Test, Skill Codes, and How to Apply. Avoid cutting and pasting the entire position
description, be precise. * This is a required field.

w | MARAY nbsp () () TM | @[3 &

Figure 21: Visual Format Editor

Helpful Hint

e In most of the drop down fields (location, classification) instead of scrolling
through the long list just type in the first letter.

* Example: In location if you know that you are looking for Salem, on your
keyboard type ‘s’ and the system will take you to the first location in
Oregon that starts with ‘s’.

Link Usage

If applicants are to complete a supplemental form avoid copying and pasting the form
into the VFE (Visual Format Editor see figure 21). Instead, import the document into
TeamSite, and create a hyperlink.



How to Import Documents

1. Ensure all files you wish to import are named oOregon.gov Fowered by ¥ INTERWOWVEN

properly in their source location; (i) File Content | workflow
names should not contain any spaces or File Edit View Actions
special characters except dashes (-) and W
underscores (_); (i) When creating folders try MEwTSTEHIr S ctaries

to use all upper or lower case. The names you || mae"™

create become part of the URL, so try to keep :g”ame

them as short as possible. wersions

2. Go to the Content tab. Delete content

+ 2 includes

3. Navigate to the Jobs folder if you are not = jobs

already in the folder. Figure 22: Selecting New Folder

4. Create a sub-folder for all attachments and
supplemental documents.

Click on File > New Folder (Figure 22).
Name the folder Attachments.
7. Click OK

Ooregon.gow Fowered by Ef INTERWOWVEN

Content | Worlkflaw

File Edit ¥iew Actions

= Internet: DAS E5] 'fi‘o-'ﬁ Sfmll96usplnz ., cust.aops-ed
+ includes “! all Files: jobs

jobs
! [IrMame

1= attachrnents

js
Lo
rmenu_files & AarPoso49z.shtmil
news [ ] arosossl.shtrl
= popularity_boxes [] £] #Pososs1a.shtml
1 images

I includes
1 jobs [] ] #aPo&007s.shtrml

[0 ] #Pos0z73.shtml

= js [ ] aFos0350.shtrml

[ ] aFosossa.shtrml

I menu_files APDASO7FE. shtrml

igure 23: Attachments folder
8. All attachments must be saved in this folder.
9. Navigate to the Attachments folder.
10. Select the Import option from the File menu.

-10 -



UrEgUﬂ.gDU Poivered by m I

Content ‘Workflow

File Edit ¥iew Actions

New Form Entry
| Mew Folder

! Impor
Ma -:rﬁ.:-\.‘s
Renames

. Tag
WVersions

| Properties

Delete Content

Figure 24: Selecting Import
Function

11. Select the directory you will import the file from in the Directory menu.

Import to: attachments

bmccorm ~| up

My Cormputer
o

Favatites
Local Settings
My Docurments
MetHood
PrintHood

File Path

Figure 25: Selecting a directory to import from

12.Navigate to the file on your system in the top window by double clicking the
folder names to open them.

13.0nce you have located the file, click the filename, and click the Add button. This
will add the file to the import list. If you do not see all your files click the gray
bar to see other folders/files.

14.When all files have been added, click the Import button at the bottom of the
screen. A window will appear displaying the import progress information. When

-11 -



the import is complete, TeamSite will display the imported files in the location
you selected — the attachments folder.

Import to: attachments

Johs Page ﬂ Up

Marme

] Creating Hyperlinks.pdf

L] Finding Saved Templates.doc
I How to Apply.doc
ClImporting Documents. doc

| oceapplication.doc

] StatedobsUpgrade new ppt
| StatedobsUporade. ppt

File Path
El cabocuments and SettingsibmccormiDeskiopllobs Page\benefits. doc

Cancel

Figure 26: Selecting Document to import
15. Publish the newly imported files by submitting them to workflow. You can publish

multiple files in the same workflow. To do this, place a checkmark by the file
name(s), click the Submit button, and follow the regular approval process.

How to create a Hyperlink in the VFE

1. Click in the VFE field to activate it.
2. If necessary, enter the text you wish to have linked.

3. Highlight the text you wish to have linked.

-12 -
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APFLICATION

Interested persons are asked to submit the following four (4) documents:

1. AResume
. Cover Letter (Mo more than two pages) describing how your expenence and education meet the

cualifications described in the “Desired Attributes™ section of this announcetment.
. AList of References that mclude at least two m each of the following categones: Peers, Subordmate,

and Professional (including necessary contact information).

A ErtdE xecutive Service Applicant Information Form

Figure 27: Highlighting text

4. In the VFE tool bar click on the New Hyperlink button.

nbsp 2] [ TH & &

Figure 28: VFE Formatting Bar

5. A secondary window will appear, click on Browse to navigate the document you

imported and link to it.

Link URL:

Target: |MNone

S @ ireemet

Figure 29: Pop box to browse for imported document

- 13 -



ea nbsp [c) () TH ||| [) €%

|Link to File

| attachments

Mame & Modified
[F] cornmdirectorapp.doc 8/10/05
[[] execserviceapp.doc /3405

i boli.doc 12/19/06

B ; 6/11/07
[[] execserviceappdeq.doc 7/10/06
[[] execserviceappDHS doc 10413706
[[] execservicsapperb.doc 2AETAOT

[[] execserviceappEss2.doc 6/20/07

- [[] execserviceappfacilitiesadmin.doc 1/24/07
Mac Editar

[[] execserviceappgspc.doc 7/19/06
= attachment 1 [[] execserviceappmaster.doc 6/20/07

axe i poaC o dor
Attachment No. 1 =

A ile name: execserviceappdas.doc
Descriptive | pp 1)

Label (7

URL to Attachment ,7
No.1 (2)

é 0 Internet

4/20/06

Figure 30: Selecting document to link to

6. Once you have found the document, select it, and click OK. This returns you to
the New Hyperlink window (Figure 31).

7. From the drop down menu, select “Same Window _Self” because you are linking
within Oregon.gov), and click OK.

-14 -



2 https://teamsite.oregon.gov - Link - Microsoft Internet ... [ |[C1[[X

Link URL: | /DS fiobs/attachmer

Same \Window (_self) ¥ || zelf

é ﬂ Inkternet
Figure 31: Confirming URL

woac | AR R nbsp (c) i) T ||[@) [ &

AFPLICATION

Interested persons are asked to submit the following four (4} documents:

. AResume

. Cover Letter (Mo more than two pages) describing how your experience and education meet the
qualifications described in the “Desired Attributes” section of this announcement.

. A List of References that mclide at least two m each of the following categories: Peers, Subordinate,
and Professional (including necessary contact information).

. A completed Executive Service Applicant Information Form (doc)

Figure 32: Established Link

8. Your Hyperlink has now been established. Remember to add a file extension to
indicate what software a user will need to open the document. Example: doc
(Microsoft Word), pdf (Adode Acrobat Reader), xIs (Microsoft Excel), etc.

Good link text should not be overly general. Do not use "click here" or “go to.” Such
statements do not indicate what the user will find by following the link. Do not use the
actual URL as the link text, e.g. das/jobs/attachments/supplement.doc. Instead, create
link text that indicates the nature of the link target, as in “Management Service

Applicant Information Form (doc)”, “Criminal Background Request Form (pdf)”, or
“Supplemental Skill Code Sheet (doc)”.

- 15 -



Completing the Job Announcement

e Once you have all of the fields filled out click Save.

e Always click Preview to see what the finished template will look like before you
publish it. In the preview mode you will be able to ensure spacing is correct and
that any and all links work.

e Close out the Preview screen.

e The template will now be on your screen.

e If changes need to be made now is the time to do it.
e Remember to click Save and Preview.

e Once you are happy with the job announcement click Finish in the bottom right
corner of the template. You are now ready to go through the Workflow process.

TIME SAVER TIP:
The Preview button will also save the template.

- 16 -



Workflow

Understanding the approval process

Content Management Workflow is an automated system that allows users to create and
manage content for the web. All document and graphic files (pdf, doc, xml, jpg, etc),
and templated files must be sent through the Workflow. Your file will not be uploaded
to the server until the Workflow has been completed.

Business Roles

TeamSite has an internal workflow process that ensures consistency in each page’s
creation, approval, and publication. A TeamSite user can serve in one, two, or all three
of these roles. These roles are determined by the SPOC (single point of contact) for
your Agency when submitting a request form for your access. A standard workflow
consists of three parts: contribution, approval, and publication.

e Contribution

Contribution is the largest portion of workflow and consists of page creation,
page submission, and metatagging. The bulk of this document is mainly focused
on the tasks involved in contribution.

e Approval

Approval is a much smaller portion of workflow. At least one approver is
required for all pages created through TeamSite, though multiple approvers can
be selected. The approval process is determined on an organization-by-
organization basis.

e Publication

Publication is the smallest portion of workflow from a user’s point of view. When
a page is approved for publication, it is pushed to the production Web server

where users can access it.

Submitting a Job Announcement Workflow

Once you have clicked Finish in the job announcement template you will submit the file
to workflow.

1. You can either Submit Now or Submit Later.
2. Click on Submit Now.

-17 -



3. Click Next.

4. Get in the habit of always clicking on Next in this screen and not changing the
drop downs.

Edit job_announcement

1. Next Action:
Submit Mow v
2. Attach to existing task or new job:

Mew Job w

<= Back | | Next == | | Cancel

Figure 33: Submitting Template

5. The Single Approver window will then load. In this window, select your
contributor, Approver and Publisher (individual or group) from the Workflow list.
An asterisk (*) indicates that this is a requirement of the Workflow process.
Pressing the Shift key allows you to select more than individual for each role
(Figure 32).

Workflow FYI:

This screen will only show when you are submitting a template. It will not show when
you are submitting a document. Figure 32 will be what you see when you submit a
document.

6. Add a description of the file and/or a note to the contributor, approver or
publisher who will receive the file in the next step of the Workflow.

7. Click once on the Start Job button on the lower right of the screen. This window
will then close. At this point a job has been created and the Workflow has been
created, and the Workflow process begun.

-18 -



Single Approver

StartJob | | Cancel Job |

Contributor{s) {**) AIMEE WHITNEY
{CTRL-Click to select multiple) *|ALLISON ABSHER
| & WELEZ
| ANGELD JORDAN
| &rMA WRIGGELSWORTH
|BARBARA HAMILTOM
|BILLI THOMPSOM
LB ALY A I ICK
Approver(s) (%) AIMEE WHIT
{CTRL-Click to select multiple) *|ALLIZON ABSHER
AMY WELEZ
ANGELO JORDAN
| &MMA WRIGGELSWORTH
|BARBARA HAMILTOM
|BILLI THOMPSOM
| BWALYA MCH ("
Publisher{s) (**} | AIMEE WHITHEY
{CTRL-Click to select multiple) *|ALLISON ABSHER
AMY WELEZ
| AMGELD JORDAN
BILLI THOMPSOM
> CORMICK
ELSWORTH
W

Description (*) * [Test Announcement

Skip Metatagger? * & ves (O No
Send Email Notifications? * O ves @ Mo

| cancel Job I

Figure 34: Single Approver Window

Helpful Hint

When selecting the contributor, approver, and publisher click in the appropriate window
and type the first letter of the name you wish to select on your keyboard. This will take
you quickly to the first name of the person that begins with this letter.

-19 -



Finishing the Workflow
Contributor

1. In your Content Workarea, click on the Workflow tab.

2. Click on the Jobs button
3. In the View drop down menu make sure that My Jobs is selected.

Oregon.goV rowered by Y INTERWOVEN

Cu:untent

] Tasks

Yiew: IM}r Jabs

Figure 35: Selecting Workflow Tab

Note:
The screen is split in half. The top part is the listing of your jobs and the bottom part

(located below the solid gray line) is called Active Tasks. You will be working in the
Active Tasks section of the Workflow. See Figure 34.

4. Go down to the Active Tasks section, and locate the small gray box between
Tasks and Task Description.
Under Task Description it should say Contributor to Add/Delete/Change...

6. Click on the small shadow box.

* If the Task Description does not say Contributor to Add/Delete/Change...
click the refresh icon on your web browser.
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oregon.gov rovered UY'g‘r'NTERWOVEN Logout | About | Help

Content | Workflow
El Jobs [] Tasks

Yiew: |My Jobs Filter: |Description

Job Description Job Mame Cner Due Date Actions

913469 O test announcement configSingleApprover bwalya.mecar... Actions =~

Requested By: bwalya.mccormick Initiated: 7/9/07 Duration:
Owner: bwalya.mecarmick Priority: + | Due Date:

Job Description:

test announcement

Active Tasks

n Task Task Descripton Marne Qwner Workarea Due Date

81343 0 I Contributor to Add/Change/Delete Files as Req EditContent <no users DAS

Figure 36: Selecting the task

7. This will open a secondary window — maximize this window.

8. Click on Take which is located in the middle of the screen between the Owner
and Priority fields.

Task Details 2677379 B save | actions= | X Close

Job 2677375 = Task 2677372
@ This task is a group task, Click 'Take' to take ownership,

@ You do not have permission to wark an this tasl.

Workarea: Internet: DAS “no users Initiated: 5/18/05

Type: Group Priority: d Due Date:
Description and Comments:

Job Description: fish & wildlife

Last Comment: Email Skipped [teamsite: 5/16/05 9:42 AM] [ +view 2 previous ]

Current Task: Contributor to Add/Change/Delete Files as Required

Attached Files < Mew File | > New Form | <% Import| [] Existing Files | [#] Madified Files

E—éf DAS/jobs/LE040193 shtm! Edit | Preview | View Differences | File Comments | File =
| DAS/jobs/LE040193supplemental doc Edit | Preview | View Differences | File Comments | File =
@—ﬁ temnplatedata/Agency_Pages/job_announcement/data/DAS/LED40195 Edit | Preview | Wigw Differences | File Comments | File &

Complete Task

Figure 37: Selecting and Taking your file
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Note: once you have taken ownership of the file no one else will be able to do so.

9. Scroll down to the bottom of the page and click Done (Figure 35). This window
will close and you will be back in the Workflow tab.

Helpful Hint

After you click the gray box and have the secondary window open there are light yellow
bars across the top of the screen. These will help guide you through what needs to be
done in order to complete the Contributor section of Workflow.

These yellow bars will show up in each secondary window.

10. Click the Go button at the top of your window (or your browser’s refresh button)
to refresh the screen. When TeamsSite has completed the task, the Task
Description will read “Set Metadata” (you may have to click the Refresh button
more than once).

11. Click the small shadow box
12. This will open another secondary window, maximize this window.
13. Click on Start Input Task — located in the bottom right hand corner (Figure 38).

oregon.gov fowered by 'ﬁ'NTERWDVEN Logout | About | Help
Content | Workflow
Cl Jobs [ Tasks

view: | My Jobs Filter: |Description

1 Job Description Job Name owner Cue Date Actions

g9z0042 O test announcement configsingleApprover bwalya.mccor... Actions =

Show: 10

Requested By: bwalya.meccarmick Initiated: 710407 Duration:

Owner: bwalya.mecormick Priority: + | Due Date:
Job Description:

test announcement

Active Tasks

4 Task Task Description Mame Qwner Workarea Due Date

gozoosod O Set metadata Metatagger bwalya.meccor... Das

Figure 38: Set Metadata
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Complete Task

.

Start Input Task

Figure 39: Selecting Start Input Task in the Task Details Window

14. A new window will open for the Metatagger, an Interwoven metadata tagging
tool.

What is metadata?

Metadata is the information you input that describes the information that can be found
within your document or template. Essentially, you are helping catalog the Oregon.gov
site for users.

There are many ways for users to find the information on your site, and your metatags
affect ALL of those methods - your keywords and page text affect the search results,
your title and description appear after a search has been run and helps guide the user
to the right page, the FindOR subjects you select help users who search for information
by topic, and your menu topic selections help users who search from the KUTs bar.
There is no metadata that is unimportant.

Metatagging

What you need to know about this screen

e Navigate the different metadata elements using the left navigation. These words
are links and will change the information you see on the right pane.

e Enter all of your values within the right pane.

e All fields with a red asterisk (*) are required fields. If information is not
entered the metatagger system will not allow you to Save and Close.
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What the buttons mean

e Copy to All will take the value that is in the first field and fill in the other empty
fields within that specific screen.

e Re-Tag will only delete or reset that one value.
e Save will do just as it says, but it won'’t close the metatagger system.

e Re-Tag All will automatically reset the values you just entered into each screen
and revert back to the suggested values — do not select this unless you want
to go back through and re-metatag.

e Cancel will close down the metatagger system without saving any of the values
you typed in. Do not select this unless you want to go back through and re-
metatag.

e Save and Close only when you have completed all required fields. This
selection will close the metatagger system and bring you back to the Workflow
tab.

Note: the following field values are auto populated, but are not set by the user:

e originatorJurisdiction is set to State of Oregon
e govType is set to State
e Retention Period Date is set to 1 year from the creation date

e Date is set to the date the file was either imported or created in the TeamSite
workarea

e dateofLastModification is set to the date the file was either imported or
created in the TeamSite workarea
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Title
This is the first thing that a consumer sees in their search results.

Be specific — instead of Job Announcement use complete descriptive phrases.
» Example — Department of Administrative Services Job Announcement.

Do not use this tag for the documents description. Title should show the user which
document they have found, not what content is contained within the document.

Do not accept the default values provided.

Tagging 2 Files

Title | APOS06EL,shtml Copy to all
Description
Keywards
FindOR Subjects
Copy to State Library [] 4POSDEEL
originatorlurisdiction Mot Applicable
originatarLevell

originatorLevel2

originatarLevel3

originatarLeveld

Resource Type

qavType

Language

Original Contral Identifier

Retention Period Textual

Retention Period Date

Drate

dateoflLastModification

Department of Administrative Services Job Announcement

Figure 40: Title Field

Description
This gives the consumer an overview of the content found within the document

Describe the document so that it is easily understood what will be found if the page is
opened

Example — This job announcement is for the DAS Director of Human
Resources and is a permanent, full time, executive service position located in
Salem, Oregon.

Do not accept the default values provided
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Tagging 2 Files

Title ] APOSOE6L. shtrml Copy to Al
Description

This job announcement is for the DAS Director of Human
Keywards Resources and is a permanent, full time, executive service
FindOR Subjects position located in Salem, Oregan )|

Copy to State Library

ariginatorlurisdiction Re-Tag
originatorLevell

originatorLevel2 ] aP0sDE61

originatorLevel3
originatorLeveld
Resource Type

govType

Language

Griginal Control Identifier
Retention Period Textual
Retention Period Date
Date
datenflLastModification

Mot Applicable

Figure 41: Description Field

Keywords

If your document is to be found when a consumer searches the web — your keywords
MUST be complete and thorough.

Any word that may be used to describe your page should be added. Separate
keywords and phrases with commas.

To get the most of your keywords, make sure you include common misspellings,
common though maybe not politically correct terms, and words that do not appear in
your page text but that people might use to find your page.

 Example — A common misspelled word is government. You should add
the misspelling of goverment.
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Tagging 2 Files

Title -] AP0s0&6L,shitml Copy to All
Description state oregon administrative adrinstration services service
Keywords stateagencies agency|

FindOR Subjects

Copy to State Library

originatarlurisdiction

originatarlevell

originatarLevelz ] APOSDEE1
originatorLevel3
originatorLeveld
Resource Type

qovType

Language

Original Control [dentifier
Retention Period Textual

Mot Applicable

Retention Period Date
Diate
dateofLastModification

Figure 42: Keywords Field

FindOR Subjects
This helps to categorize your content so that it may more easily be found.

e The FindOR Subijects list is a pre-established list of topics. This list is rigid, but
for very good reason - it creates a consistent set of search values through out
the entire Oregon.gov Web site.

e If your content belongs to more than one category be sure to add multiple
entries.

e To add new FindOR Subijects, select Add/Edit.

e Type and select all of the terms that describe your content by clicking Add next
to each match.

e To select another level within the category select Refine.
e If necessary search additional terms.

e When finished adding keywords, select Done.

- 27 -



Tagging 2 Files
Title -] APO5066E1.shtml Copy to Al

Description - - -
P Doing business with the government A
Keywords State gavernment risk management
FindOR Subjects State government
Copy to State Library State government technalogy

W

. . State government internal operations
originatordurisdiction 2 P
originatorLevell add/Edit |) Re-Tag
originatorbevel2

originatorLeveld 5] APOS0661

Mot Applicable

originatorLeveld
Resource Type

qovType

Language

Original Contral Identifier
Retention Period Textual
Retention Period Date
Date
dateafLastmadification

Figure 43: FindOR Field

Copy to State Library

Job Announcements fall under the category of documents that do not need to be sent
to the library to be stored in the Public Document Repository. Other examples include
forms, press releases, minutes, agendas, and meeting announcements. Check No.

Tagging 2 Files

Title [] APOS0E61.shtml T
Description OYe i

Keywards

FindOR Subjects

Copy to State Library
ariginatorlurisdiction Mot Applicable
originatorLevell

-] APOS0661

originatorLevel2
originatorLevel3

originatorLeveld

Resource Type

govType

Language

Criginal Control Identifier
Retention Period Textual
Retention Period Date
Date
dateofLastModification

Figure 44: Copy to State Library Field
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Originatorlevell
This describes the parent agency to which the content belongs.

e To add new agencies, select Add/Edit.

e Type in the name of the content owner’s agency (acronym or full name).
e Click on the agency.

e Select Add/Refine.

e When finished click Done.

Tagging 2 Files

Title -] Ar0S0661.shtml Copy to All
Description
keywords

FindOR Subjects
Copy to State Library

originatorlurisdiction
originatorLevell Add/Edit |) Re-Tag
originatorLevel2

administrative Services Dept,

originatorLeveld ] AP050861
originatorLeveld

Resource Type Mot Applicable
qovType

Language

Original Contral Identifier
Retention Period Textual
Retention Period Date
Date

dateofLastModification

Figure 45: originatorlevell field

originatorLevel2, 3 and 4 (optional)
For Level 2 you will follow the same instructions for Level 1, but you will put in the
Division name.

Levels 3 and 4 you can enter directly into the field without selecting Add/Edit. The
information in Level 3 would be the Section name. Level 4 would have the Program
name.

e Example: DAS/HRSD/Statewide Training & Development/Leadership Oregon

- 29 -



Retention Period Date
This identifies the date that your content should be removed for archiving.

e Enter the date in yyyy-mm-dd format.
e |If your announcement has a close date, use this as the retention period date.

e If your announcement is Open Until Further Notice or Open Until Filled use the
system default date.

Tagging 2 Files

Title -] AP0S06EL shitrml Copy to All
Diescription
Keywords

FindOR Subjects
Copy to State Library
ariginatorlurisdiction Mot Applicable
originatorLevell

originatorLevel2

originatorLevel3

originatorLeveld

Resource Type

govType

Language

Original Control Identifier

Retention Period Textual

Retention Period Date

Date

dateofLastModification

2006-11-09

-] aP0S0EEL

Figure 46: Retention Period Date field

Date

e This identifies the date that your content was created.
e Enter the current date in yyyy-mm-dd format.
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Tagging 2 Files

Title -] APOS0661.shtml Copy to All
Description 2005-11-00

Keywords

FindOR Subjects
Copy to State Library
originatordurisdiction Mot Applicable
originatorLevell

originatorLevel2

originatorLevel3

originatorLeveld

Resource Type

govType

Language

Original Contral Identifier

Retention Period Textual

Retention Period Date

Date

datecfLastModification

] aPOS0G6L

Figure 47: date field

When you have completed metatagging, click Save and Close at the bottom right of the
window.

An Add Comments screen will appear. Add any comments that you wish to send to the
Approver or Publisher. When you are done click OK.

Add Comments for Task 8920050

Task Comments:

/7~ N\
w Cancel

Figure 48: Task Comment field

TeamsSite will now process the task. In the task description you will see this comment
“Email the Approver Group that...”

If you are the Contributor your Workflow is complete and your file will be sent to the
person you assigned as Approver. If you are both the Contributor and the Approver, the
Approver step will be skipped and the task will move on to the Publisher phase.
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Publisher

The publisher is responsible for approving and deploying (or schedule deployment of)
the file or rejecting the file and sending it back to the contributor:

Click on the Jobs button.

In the View menu select My Jobs.

Select the file you wish to send through the Workflow.

N

In the task details window click on the small shadow box, near the middle of the
screen. The task is now open. You will notice that the Task Description says
“Publisher to Review Content”.

Requested By: bwalya.mecormick Initiated: 7/10/07 Duration: 0 days

Owner: bwalya.mecarmick Priority: + | Due Date:

Job Description:

test announcement

Active Tasks

I Task Task Description Name Qwner warkarea Due Date
892005 ° Publisher to Review Content PublisherReview N0 Users DAS

Figure 49: Selecting the Publisher

Note: Click the Go button at the top of your window (or your browser’s refresh
button) to refresh the screen if you do not see “Publisher to Review Content”.

5. This will open a secondary window - maximize this window.

6. Click on Take which is located in the middle of the screen between the Owner
and Priority fields
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Task Details 8920052 B Save | Actions= | X Close

Job 8920042 = Task 8920052

® Task is read only, Files can be viewed, but not modified,

@ This task is a group task, Click ‘Take' to take ownership,

@ You do not have permission to work an this task,

Workarea: Internet: DAS ser>

Type: Group Priority: 4| Due Date:

Initiated: 7/10/07

Figure 50: opening task for publishing

7. On the bottom, right hand corner of your screen there are three (3) choices:
* Approve and Deploy
* Approve and Schedule Deployment

* Reject

Complete Task

Approve and Deploy |fApprove and Schedule Deploy § Reject

Figure 51: Publisher Options

8. If you want the job announcement to publish immediately select Approve and
Deploy.

9. If you want to schedule the deployment select Approve and Schedule
Deployment.

10.The Reject button will more than likely not be used for a job announcement. If
you accidentally select it the system will take you back to the Approver stage
(which you skip if you select yourself in all 3 categories).

Approve and Schedule Deployment

Click on Take.

Click on Approve and Schedule Deployment.

The secondary will close and take you back to workflow.
Go back to the Active Tasks.

WD PE
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5. The Task Description will say “Publisher Picks When They Want the
Deployment..."
6. Click the small gray box to open a secondary window.

Active Tasks

Cwner Workarea Due Date

Task Task Description MNarne
892006@ PublisherPicks When They Want the Deployme... ScheduleDeployment bwalya.meear,.. DAS

!

Figure 52: Taking task to schedule deployment

7. Click on Start Input Task

it) El il

Attached Files

B4 DASAobs/APOS0661.shtml Preview | View Differences | File Comments | File =

B4 templatedata/dgency_Pages/ob_announcement/data/DAS/APIS0661 Preview | View Differences | File Comments | File =

Complete Task

Start Input Task

Figure 53: Start Input Task
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8. A calendar and clock will come and you will then have the ability to specify the
time and date the template or document will be published (Figure 54).

Note: the system backs up in the early hours of the morning, so resist the urge to
have a job deploy between the hours of 1 a.m. and 6 a.m. because it may not deploy
during that time.

Date & Time Selection:
Please note that the scheduler can only handle dates within the next year.

|D1 j W Iam j I _View Calendar

Cancel | Submitl

Figure 54: Date and Time Selection

9. Click on Submit.
10. This job will stay in your Workflow until it publishes.

Resubmitting a job announcement template

If you need to make any changes to a template or document you will need to go
through the workflow process (or a resubmit).

e You will need to put a check mark in front of the template and click on Edit.
e This will bring the template up on your screen.
e Make the necessary changes and click Preview.

e Once you click Preview the system will pull your job announcement off
the jobs page, and you will need to complete workflow in order for the
announcement to show on the jobs page.

e If there are no additional changes that need to be made close out the preview
screen.

e Click on Next.

e A pop-up box will appear and ask if you would like to regenerate ~ yes or no.
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e Always click No; If you answer Yes it will open up what looks like a preview
screen and if you have not been trained on how to go through workflow this way
do not attempt it.

e The rest of the Workflow process is the same.

Exception to the resubmit rule

If you have made an error in the job announcement number and have already saved
and published the job DO NOT go back and try to edit it; editing the announcement
number after the template has been saved will create duplicate announcements.
Instead, unpublish the job, and create a new announcement with the correct
announcement number. You can cut and paste from the previous job announcement
template to reduce the amount of work.
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Additional Information

If you are in need of more assistance, here are some resources available.

Online Support Documentation
https://intranet.egov.oregon.gov/sites/DAS/IRMD/EGOV/CLASS/
Technology Support Center

egovhelp@das.state.or.us
(503) 378 2126
Statewide Training & Development Classes (Web Contribution and Advanced)

http://www.oregon.gov/DAS/HR/training.shtml
Rhea Rodriguez (503) 378 5393
Additional Assistance
Bwalya McCormick (503) 378 2817; Bwalya.McCormick@state.or.us
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